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Section 1: Introduction

Section 1: Introduction

This section includes contact information, Quick Start procedure, and photos
of astandard SBE 48 shipment.

About this Manual

This manual isto be used with the SBE 48 Hull Temperature Sensor.

It is organized to guide the user from installation through operation and data
collection. We've included detailed specifications, command descriptions,
maintenance and calibration information, and helpful notes throughout

the manual.

Sea-Bird welcomes suggestions for new features and enhancements of our
products and/or documentation. Please e-mail any comments or suggestions to
seabird@seabird.com.

How to Contact Sea-Bird

Sea-Bird Electronics, Inc.
1808 136" Place Northeast
Bellevue, Washington 98005 USA

Telephone: 425-643-9866

Fax: 425-643-9954

E-mail: seabird@seabird.com
Website: http://www.seabird.com
Business hours:

Monday-Friday, 0800 to 1800 Pacific Standard Time
(1600 to 0200 Universal Time)

Except from April to October, when we are on ‘ summer time’
(1500 to 0100 Universal Time)

Quick Start

Follow these stepsto get a Quick Start using the SBE 48. The manual provides
step-by-step details for performing each task:

1. Test Power and Communications (see Section 3: Preparing the SBE 48
for Deployment).

2. Deploy the SBE 48 (see Section 4: Deploying and Operating the SBE 48):
A. Install anew battery if necessary (see Section 5: Routine

Maintenance and Calibration).

Set time and date.

Establish logging parameters.

Ensure all data has been uploaded, and then set SAM PLENUM =0 to

make entire memory available for recording if desired.

Set SBE 48 to start logging now or in the future.

Install dummy plug or 1/0O cable, and locking sleeve.

Using magnets on housing, mount SBE 48 on inside of ship’s hull

below the waterline.

O0Ow
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Section 1: Introduction

Unpacking the SBE 48
Shown below isatypical SBE 48 shipment.

SBE 48

1/0 Cable

9-pin adapter

Wi R
[
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Section 2: Description of the SBE 48

Section 2: Description of the SBE 48

This section describes the functions and features of the SBE 48, including
specifications and dimensions.

System Description

Notes:

» Help files provide detailed
information on the use
of SEATERM and PLOT39.

» A separate software manual
contains detailed information
on the setup and use of
SEASOFT.

The SBE 48 is a high-accuracy temperature recorder with non-volatile
memory, designed for shipboard determination of sea surface temperature.
Installed with magnets just below the water line, the SBE 48's temperature
sensor isin contact with the inside of the ship’s hull. The SBE 48'sinternal
battery runs the real-time clock and can be used to power the SBE 48 for very
short deployments; external power is recommended for typical deployments.

The SBE 48 retains the temperature sensor used in the SBE 39 Temperature
Recorder. The SBE 48’ s thermistor has along history of exceptional accuracy
and stability (typical drift islessthan 0.002 °C per year).

The SBE 48 communicates directly with a computer via a standard RS-232
interface. Baud rates of 1200 to 38,400 are user-selectable. Setup and
extraction of data from the SBE 48 is done via an 1/O data cable plugged into
an external connector. Calibration coefficients stored in EEPROM allow the
SBE 48 to transmit data in engineering units.

Commands can be sent to the SBE 48 to provide status display, data
acquisition setup, dataretrieval, and diagnostic tests. User-sel ectable operating
modes include:

*  Polled sampling — The SBE 48 takes one sample and sends the data to the
computer. Polled sampling is useful for testing.

*  Autonomous sampling — There are two types of Autonomous sampling.
» Interval sampling: At pre-programmed intervals, the SBE 48
wakes up, samples, stores datain memory, and powers off
(enters quiescent mode).
»  Continuous sampling: The SBE 48 continuoudy samples and stores
datain memory, and does not power off between samples.
The SBE 48 also calculates a running average of up to 120 temperature
samples, which can be transmitted while logging data.

* Serial Line Sync - A pulse on the serial line causes the SBE 48 to wake
up, sample, store datain memory, and power off. This mode provides
easy integration with other instruments that can synchronize SBE 48
sampling with their own.

The SBE 48 is supplied with a powerful software package that includes:

e SEATERM - Win 95/98/NT terminal program for easy communication
and dataretrieval.

* PLOT39-Win95/98/NT program for plotting data from an SBE 48 or
SBE 39.

* SEASOFT - DOS programs for calculation, display, and plotting of
temperature. SEASOFT is designed to run on IBM compatible computers
(XT/ATI386/486/Pentium). These programs usually perform correctly
when run under Windows.
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SBE 48 Specifications

Measurement | -5to +35 °C
Range

Initial 0.002 °C
Accuracy

Typical 0.0002 °C
Stability

(per month)

Resolution 0.0001 °C
Sensor -1to +32 °C
Calibration

Memory 2M byte non-volatile FLASH memory

Data Storage

Converted temperature: 3 bytes per sample.
Time: 4 bytes per sample.

Memory space: 276,000 samples.

Note:

If the SBE 48 is logging data and
the voltage is less than 6.25 volts
for 10 consecutive scans,

the SBE 48 halts logging and
displays a low battery indication
in the data.

Real-Time Watch-crystal type 32,768 Hz;

Clock Accuracy 15 seconds/month

Internal 9-volt lithium battery (unrestricted) - runs real-time

Battery clock; can also be used to power SBE 48, if external
power is not supplied

External 8- 16 VDC.

Power The SBE 48 is typically deployed with external
power. The internal lithium battery is diode-OR’d with
the external source, so power will be drawn from
whichever voltage source is higher.

Current Quiescent Current: 10 microamps
Current Consumption per Sample: 0.015 amp-second

Battery Running clock only: 5 to 10 years

Endurance Providing power for logging: 150,000 samples

Materials PVC housing

Weight 2.3 kg (5 Ibs)
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SBE 48 Dimensions in millimeters (inches)

273 (10.75)
78 (3.08)
— 1 T
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76 (3.00) ® ®
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Section 3: Preparing the SBE 48 for Deployment

Section 3:

Preparing the SBE 48 for Deployment

This section describes the pre-check procedure for preparing the SBE 48
for deployment.

Power and Communications Test

Note:

Sea-Bird ships the SBE 48 with a 9-volt
lithium battery installed. See Section 5:
Routine Maintenance and Calibration
for details on replacing the battery.

Note:

It is possible to use the SBE 48 without
SEATERM by sending direct
commands from a dumb terminal or
terminal emulator, such as Windows
HyperTerminal.

1/0 cable
connector

3 D
S,
®

The power and communications test will verify that the system works,
prior to deployment.

Test Set-Up

1. If not already installed, install SEATERM and other Sea-Bird software
programs on your computer using the supplied software CD:
A. Insert the CD inyour CD drive.
B. Double click on Setup.exe.
C. Follow the dialog box directionsto install the software.
The default location for the software is c:/Program Files/Sea-Bird. Within
that folder is a sub-directory for each program.

2. Ingtall the 1/O cable connector:
A. Lightly lubricate the sides of the rubber prongs on the SBE 48
bulkhead connector with silicone grease (DC-4 or equivalent).

B. Install the cable connector, aligning the holes with the five pins on the
SBE 48's bulkhead connector.

C. Placethelocking sleeve over the connector. Tighten the locking
deeve finger tight only. Do not overtighten the locking sleeve and
do not useawrench or pliers.

Pin Description

1 Ground

2 Transmit: RS-232C transmit data
from SBE 48 to computer

3 Power: 8 - 16 VDC external power

4 Receive: RS-232C receive data
transmitted from computer

5 Shield

D. Connect the I/O cable connector to your computer’s serial port.
A 25-t0-9 pin adapter is supplied for use if your computer has a 9-pin
serial port.

E. Connect the I/O cable connector’s red (+) and black (-) wiresto a
power supply (8 - 16 VDC).

10



Section 3: Preparing the SBE 48 for Deployment

Notes:

e See SEATERM's help files for
detailed information on the
use of the program.

e The SBE 48 is not available
in the list of instrument types.
Select the SBE 39 as the
instrument type.

Test
Proceed as follows:

Double click on SeaTerm.exe. If thisisthe first time the program is used,
the setup dialog box appears:

The conhqueation file: SeaT=amoly
war reol found in the apphcation

“IMPORTANT: To complebe selup,
1ewview the conliguation sething (o
poul mslrumesnd By selecking sour
msknament ippe from the Configuie
marw ligh

Instumend Tope (R =~ <)
amr [ ]
Lo |
Select the instrument type (SBE 39) and the computer COM port for
communication with the instrument. Click OK.

2. The main screen looks like this:

o Pl Condges Cowmcsiors Uilian Qe Ves Wb |e|enUS ..j.ﬂ.l.ﬂ|

Note:

There is at least one way, and as

many as three ways, to enter

a command:

» Manually type a command in
Command/Data Echo Area

« Use a menu to automatically
generate a command

» Use a Toolbar button to
automatically generate
a command

B | % l|"‘:. l|un|-=a|l w || R
Comred | Sl 1, melruorrs ] Ligican e
Toolbar
Command/Data Echo Area
Capture
Status bar to file
status —
grayed
Computer Upload out if not
Instrument COM port parameter capturing
e Y =i T T BT (]
Instrument Baud rate, data bits,

Note:

Once the system is configured and

connected (Steps 3 and 4 below),

to update the Status bar:

« on the Toolbar, click Status; or

« from the Utilities menu, select
Instrument Status.

SEATERM sends the status

command, which displays in the

Command/Data Echo Area, and

updates the Status bar.

EPROM version stop bits, and parity

*  Menus— Contains tasks and frequently executed instrument
commands.
*  Toolbar — Contains buttons for frequently executed tasks and

instrument commands. All tasks and commands accessed through the

Toolbar are also available in the Menus. To display or hide the
Toolbar, select View Toolbar in the View menu. Grayed out Toolbar
buttons are not applicable.

e Command/Data Echo Area— Echoes a command executed using a
Menu or Toolbar button, as well as the instrument’ s response.

Additionally, acommand can be manually typed in this area, from the
available commands for the instrument. Note that the instrument must
be awake for it to respond to a command (use the Connect button on
the Toolbar to wake up the instrument).

Status bar — Provides status information. To display or hide the Status
bar, select View Status bar in the View menu.

11



Section 3: Preparing the SBE 48 for Deployment

Following are the Toolbar buttons applicable to the SBE 48:

Toolbar Description Equivalent
Buttons Command*
Connect Re-establish communications with SBE 48. |(press Enter

Computer responds with S> prompt. key)

SBE 48 goes to sleep after two minutes

without communication from computer

have elapsed.

Status Display instrument setup and status DS
(logging, number of samples in memory,
etc.).

Coefficients |Display calibration coefficients. DC

Capture Capture instrument responses on screento |—
file. File has .CAP extension. Press Capture
again to turn off capture. Capture status
displays in Status bar.

Upload Upload data stored in SBE 48's memory, in |DDb,e (use
format SEASOFT’s Convert module Upload key
(CNV39) can use to allow for post- if you will be
processing in SEASOFT. Uploaded data post-
has .ASC extension. processing
Before using Upload: data with
*  Configure upload and header SEASOFT)

parameters in Configure menu
« Send STOP command to stop logging.

Convert (not functional as of 11/1/00) —
Convert uploaded ASCII data to .CNV data,
which can then be processed by SEASOFT.
This performs the functions of CNV39
in SEASOFT.

Diagnostics |Perform one or more diagnostic tests on DS, DC, TS,
SBE 48. Diagnostic test(s) accessed in this |and TSR
manner are non-destructive —
they do not write over any existing
instrument settings.

Stop Interrupt and end current activity, such as —
logging, uploading, or diagnostic test.

Disconnect |Free computer COM port used to —
communicate with SBE 48. COM port can
then be used by another program.

*See Command Descriptions in Section 4: Deploying and Operating

the SBE 48.

12




Section 3: Preparing the SBE 48 for Deployment

3. Inthe Configure menu, select SBE 39. The dialog box looks
like this:

SBE 39 Configuration Dptions E

[

COM Settings T Uplc_iad,SE:t.Eing% T Header Information

Computer COM port, baud rate,
data bits, and parity for
communication between computer
and SBE 48

EFROM Versioh Interface for communication
i between computer and
SBE 48
4 A s
COkM Porl  Baud Rate =Mode
R B EET " R5-232 (Full Duples]
£ R e p(ea
~DaaBits £ aelve M edem
| ' Moder/RS485 10—
- Parity £ Sty
‘ £ e 0 ) None €= AlamatizaliigeD
Eanecel Dfault Help oK

Make the selections in the Configuration Options dialog box:

COMM Port: COM 1 through COM 10, as applicable

Baud Rate: 9600 (documented on front cover of this manual)
Data Bits: 8

Parity: None

Mode: RS-232 (Full Duplex)

Click OK to overwrite an existing configuration file, or click Save Asto
save the configuration as a new filename.

4. Click the Connect button on the Toolbar. The display looks like this:

SBE 48
S

This shows that correct communications between the computer and the
SBE 48 has been established.
If the system does not respond as shown above;

Click the Connect button again.

Verify the correct instrument was selected in the Configure menu and
the settings were entered correctly in the Configuration Options
dialog box. Note that the baud rate is documented on the front cover
of this manual.

Check cabling between the computer and the SBE 48.

13



Section 3: Preparing the SBE 48 for Deployment

Note:

The SBE 48 has a 2 minute timeout

algorithm designed to:

« restore control to the computer if
an illegal command is sent

» conserve power if too much time
elapses between commands

If the system does not appear to

respond, click Connect on the

Toolbar to reestablish

communications.

5.

Display SBE 48 status information by clicking the Status button on the
Toolbar. The display looks like this:

SBE 48V 1.0 SERIAL NO. 0916 08 Aug 2000 08:49:09
logging not started

sampleinterval = 30 seconds

number of samplesto average = 60

samplenumber = 2, free = 299591

serial sync mode disabled

real-time output disabled

temperature=19.48 deg C

Command the SBE 48 to take a sample by typing TS and pressing the
Enter key. The display looks like this:
23.7658, 08 Aug 2000, 08:50:23
where 23.7658 = temperature in degrees Celsius

08 Aug 2000 = date

08:50:23 = time
These numbers should be reasonable; i.e., room temperature, current date
and time (Pacific Daylight or Standard Time).

Command the SBE 48 to go to sleep (quiescent mode) by typing QS and
pressing the Enter key.

The SBE 48 isready for deployment.

14



Section 4: Deploying and Operating the SBE 48

Section 4: Deploying and Operating
the SBE 48

This section provides instructions for deploying the SBE 48.

Note: . . . . .
A separate software manual contains It also includes a discussion of system operation, example sets of operation
detailed information on installation, commands, and detailed command descriptions.

setup, and use of SEASOFT.

Set-Up for Deployment

1. If not providing external power, install a new battery or ensure the
existing battery has enough capacity to cover the intended deployment.
See Section 2: Description of the SBE 48 for battery endurance
specifications and Section 5: Routine Maintenance and Calibration for
details on battery replacement.

2. Program the SBE 48 for the intended deployment (see Section 3:

Notes: Preparing the SBE 48 for Deployment for connection information; see
+ Ifthe battery has been removed, information in this section on commands and sampling modes):

the date and time must be reset.
« Itis always necessary to set both A. Set thetime and date.

date and time. If a new date is
entered but not a new time, the

new date will not be saved. B. Establish thelogging parameters.

C. Ensure al data has been uploaded, and then set SAMPLENUM =0 to
make the entire memory available for recording. If SAMPLENUM is
not reset to zero, data will be stored after the last recorded sample.

D. Useone of the following sequences to initiate logging:
» STARTNOW to start logging now, taking a sample every

Note:

If INTERVAL=0, the SBE 48 will INTERVAL seconds.

sample continuously, without e STARTMMDDYY=, STARTHHMM SS=, and

powering down between samples. STARTLATER to start logging at the specified date and time,
taking asample every INTERVAL seconds.

* SYNCMODE-=Y to place the SBE 48 in serial line sync mode,
so that asimple pulse on the RS-232 line will initiate a sample.

15



Section 4: Deploying and Operating the SBE 48

Deployment

1. Instal the I/O cable connector:

A. Lightly lubricate the sides of the rubber prongs on the SBE 48
bulkhead connector with silicone grease (DC-4 or equivalent).

B. Install the cable connector, aligning the holes with the five pins on the
SBE 48's bulkhead connector.

1/0 cable
connector

C. Placethelocking sleeve over the connector. Tighten the locking
deeve finger tight only. Do not overtighten the locking sleeve and
do not useawrench or pliers.

D. Connect the 1/O cable connector to your computer’s serial port.

A 25-t0-9 pin adapter is supplied for use if your computer has a 9-pin
serial port.

E. Connect the I/O cable connector’s red (+) and black (-) wiresto a
power supply (8 - 16 VDC).

Locking sleeve

2. Generoudly coat the temperature sink with heat sink grease.

Magnet Temperature
(4 places) sink

3. Mount the SBE 48 on the inside of the ship’s hull, using the magnets.

Ship's hull Excess heat sink grease should squeeze out the side of the
| 3y I O temperature sink.
grease * |If excess grease does not squeeze out the side, the temperature
Magnet Temperature Magnet sink may not bein good contact with the hull. Remove the SBE 48
sink from the hull, apply more heat sink grease, and remount.

16



Section 4: Deploying and Operating the SBE 48

Sampling Modes

The SBE 48’ s user-selectable sampling modes for obtaining data include:

* Polled Sampling

*  Autonomous Sampling - Interval Sampling and Continuous Sampling

*  Serid Line Synchronization

Commands can be used in various combinations to provide a high degree of
operating flexibility.

Descriptions and examples of the sampling modes follow. Note that the
SBE 48’ s response to each command is not shown in the examples. Review
the operation of the sampling modes and the commands described in
Command Descriptions before setting up your system.

Polled Sampling (Operating commands)

The SBE 48 takes one sample of data and sends the data to the computer.
Storing of datain the SBE 48's FLASH memory is dependent on the particular
command used.

Example: Polled Sampling

Establish communication with SBE 48. Command SBE 48 to take
a sample and send converted data to computer (do not store data
in memory). Send power-off command to SBE 48.

(click Connect on Toolbar)
SSTS
S>QS

17
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Autonomous Sampling (Logging commands)
There are two types of Autonomous sampling:

Note:

Use the STOP command to:

» stop logging

» stop waiting to start logging
(after STARTLATER command
has been sent)

Interval sampling: At pre-programmed intervals, the SBE 48 wakes up,
samples data and storesit in FLASH memory, and powers-off
(enters quiescent mode). The sampling interval is set with the
INTERVAL command.

Continuous sampling: The SBE 48 continuously samples data and stores it
in FLASH memory, and does not power-off between samples. Continuous

sampling is established by setting INTERV AL =0.

Logging is started with STARTNOW or STARTLATER, and is stopped
with STOP. Transmission of real-time data to the computer is dependent on
TXREALTIME.

Example: Autonomous Sampling - I nterval Sampling
Establish communication. Set sample number to 0 to overwrite
previous datain memory. Set up to sample every 10 seconds,
store datain memory, and start on 10 January 2000 at 12:00:00.
Do not transmit real -time data to computer. Send power-off
command to SBE 48.

(Click Connect on Toolbar)
SSSAMPLENUM=0
S>INTERVAL=10
SSSTARTMMDDY Y =011000
S>STARTHHM M SS=120000
S>STARTLATER
SSTXREALTIME=N

SQS

When ready to upload all datato computer, establish
communication with SBE 48, stop sampling, and upload data.
Send power-off command to SBE 48.

(Click Connect on Toolbar)

(Press Enter key to get S> prompt)
S>STOP

(Click Upload on Toolbar — program leads you through screens to
define data to be uploaded and where to store it)
SQS

Example: Autonomous Sampling - Continuous Sampling
Same as above, but set INTERVAL=0.

18
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Serial Line Sync

Serial Line Sync allows a simple pulse on the RS-232 line to initiate a sample.
This mode provides easy integration with other instruments that can
synchronize SBE 48 sampling with their own without drawing on their battery
Or Memory resources.

If thismode is enabled (SYNCM ODE=Y) and the SBE 48 is powered down,
setting the RS-232 RX line high (3 -10 VDC) for 1 to 1000 milliseconds

wakes up the SBE 48 and executes a Take Sample command:
* Takesample

*  Store samplein FLASH memory

e Output rea-time dataif TXREALTIME=Y

The SBE 48 then checks the RS-232 line;
* Mark State (RS-232 RX line less than 0.5 volts)

SBE 48 immediately powers down. Serial line sync mode remains enabled

(SYNCM ODE=Y).

* Space State (RS-232 RX line greater than 3 volts)
SBE 48 monitors the RS-232 line for 100 milliseconds:

Note:

If running SEATERM, select
Send 5 second break in the
Communications menu to hold the
RS-232 RX line in space state

for 5 seconds. This will cause

the SBE 48 to exit Serial Line
Sync Mode.

» Lineremainsin space state - SBE 48 disables serial line sync mode

(SYNCM ODE=N) at end of time. Once serial line sync mode is
disabled, you can communicate with the SBE 48 using the full range
of commands (operating, logging, upload commands, etc.).
Linereturnsto mark state - SBE 48 immediately powers down. Serial
line sync mode remains enabled (SYNCM ODE=Y).

In summary, to disable serial line sync after executing the Take Sample
command, put the RS-232 line in space state (greater then 3 volts) for
100 milliseconds.

Example: Serial Line Sync Mode

Establish communication with SBE 48. Reset sample number to
zero to overwrite previous datain memory. Do not transmit real-
time data to computer. Enable serial line sync mode.

(Click Connect on Toolbar to wake up)
SSSAMPLENUM=0
SSTXREALTIME=N

S>SYNCM ODE=Y

SQS

Take samples using serial line sync mode:

(Set RS-232 RX line high [3-10 VDC] for 1-1000 milliseconds.
SBE 48 takes sample and stores data in memory. Within

100 milliseconds, set RS-232 RX line to mark state [less than
0.5 volts] — SBE 48 powers down.)

(Repeat this process at periodic intervals as desired.)

When ready to upload all datato computer, disable serial line
sync mode, and then upload data and power down:

(Set RS-232 RX line high [3-10 VDC] for 1-1000 milliseconds.
SBE 48 takes sample and stores datain memory)

(Select Send 5 second break in Communications menu to disable
seria line sync mode.)

(Press Enter key to get S> prompt.)

S>DS  (to verify SBE 48 is communicating)

S>(Click Upload on Toolbar — program leads you through screens
to define data to be uploaded and where to store it)

SQS

19



Section 4: Deploying and Operating the SBE 48

Command Descriptions

Note:

If the voltage is below 6.25 volts,
the following displays in response
to the status command:
WARNING: LOW BATTERY
VOLTAGE!! Ensure the external
power supply is adequate

before continuing.

This section describes commands and provides sample outputs.
See Appendix I11: Command Summary for a summarized command list.

When entering commands:

Input commands to the SBE 48 in upper or lower case |etters and register
commands by pressing the Enter key.

The SBE 48 sends‘? CM D’ if an invalid command is entered.

If the system does not return an S> prompt after executing a command,
press the Enter key to get the S> prompt.

If a new command is not received within two minutes after the completion
of acommand, the SBE 48 returns to the quiescent (eep) mode to
prevent exhaustion of its battery.

If in quiescent mode, re-establish communications by clicking the
Connect button on the Toolbar or pressing the Enter key to get an
S> prompt.

Status Command

DS

Display operating status:

» firmware version, serial number, date
and time

* logging status

* sampleinterva time

*  number of samplesto average
(running average)

e number of samplesin memory,
available sample space in memory

» seria line sync mode status

* rea-time output status

*  current temperature

Logging status can be:

* logging not started

* logging data

* notlogging: waiting to start at...

* not logging:received stop command
* notlogging: low battery

* unknown status

Equivalent to Status button on Toolbar.

Example: Display status for SBE 48.

S>DS

SBE 48V 1.0 SERIAL NO. 0916 08 Aug 2000 08:49:09
logging not started

sampleinterval = 30 seconds

number of samplesto average = 60

samplenumber = 2, free = 299591

serial sync mode disabled

real-time output disabled

temperature=19.48 deg C
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Setup Commands

Notes:

« DDMMYY= and MMDDYY=
commands are equivalent. Either
can be used to set the date.

« Always set both date and time.

If a new date is entered but not a
new time, the new date will not
be saved.

« If the SBE 48 battery has been
removed, date and time must
be reset.

« If the SBE 48 is logging or is
waiting to start logging
(STARTLATER command has
been set), it will not allow the user
to reset the date or time.

Note:

The SBE 48'’s baud rate (set with the
BAUD command) must be the same
as SEATERM'’s baud rate (set in the
Configure menu).

BAUD=x

NAVG=n

Notes:

« TXREALTIME applies to
autonomous mode (continuous or
interval sampling) and serial line
sync mode.

» To capture real-time data to
a file, do the following before
starting logging:

A.Click the Capture button on
the Toolbar.

B.Enter the desired file name in
the dialog box. The capture
status displays in the status bar
at the bottom of the screen.

Note:

See Sampling Modes for complete
details on the operation of serial
line synchronization.

MMDDYY=mmddyy Set real-time clock month, day, and year.

This command must be followed by
HHM M SS= command to set time.

DDMMYY =ddmmyy Set real-time clock day, month, and year.

This command must be followed by
HHM M SS= command to set time.

HHM M SS=hhmmss Set real-time clock hour, minute,

and second.

Example: Set current date and time to 10 January 2000 12:00:00.

SSMMDDY'Y=011000
SSHHM M SS=120000

or

SSDDMMY'Y=100100
SSHHM M SS=120000

x= baud rate (1200, 2400, 4300, 9600,
19200, 38400). Default 9600.

Set number of scansin the running
averageto n (1 - 120). Running average is
reset to O when STARTNOW or
STARTLATER command is sent.

TXREALTIME=x x=Y: Output real-time data to the

computer. Data is transmitted immediately
after it is sampled. Thisdoes not affect
storing data to FLASH memory, but
dlightly increases current consumption
and increases amount of time needed to
sample (and then transmit) data.

x=N: Do not output real-time data.

SYNCM ODE=x x=Y: Enable Serial Line Sync Mode.

QS

When RS-232 RX lineis high (3-10 VDC)
for 1 to 1000 milliseconds, SBE 48 takes a
sample, storesdatain FLASH memory,
transmits real-time data (if
TXREALTIME=Y), and powers down.

x=N: Do not enable Serial Line
Sync Mode.

Quit session and place SBE 48 in
quiescent (seep) mode. Main power is
turned off. Data logging and memory
retention are not affected.
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Note:

If the SBE 48 is logging data and the
voltage is less than 6.25 volts for

ten consecutive scans, the SBE 48
halts logging and sets the logging
status to low battery.

L ogging Commands

SAMPLENUM=n

Note:

SAMPLENUM=0 does not delete the
data; it just resets the data pointer.

If you accidentally send this
command before uploading,

see Memory in Appendix I:

Functional Description for a
discussion of how to recover the data.

INTERVAL=n

Logging commands direct the SBE 48 to sample data at pre-programmed
intervals and store the datain its FLASH memory.

Set sample number for first sample when
logging beginsto n. After al previous data
has been uploaded from SBE 48, set
sample number to zero before starting to
log to make entire memory available for
recording. If SAMPLENUM is not reset
to zero, data will be stored after last
recorded sample.

Set interval between samplesto n seconds
(O, or 3to 32767). This sets up the SBE 48
in Autonomous sampling mode. When
commanded to start sampling with
STARTNOW or STARTLATER,

SBE 48 takes a sample, stores datain
FLASH memory, transmits real-time data
(if TXREALTIME=Y), and powers down
at n second intervals.

If n=0, SBE 48 samples continuously
without powering down between samples.
The table below provides the approximate
interval between samples:

Output

Time (seconds)

Not real-time (TXREALTIME=N)

0.80

Real-time (TXREALTIME=Y)

1.00

STARTNOW

Note:

STARTDDMMYY and
STARTMMDDYY are equivalent.
Either can be used to set the delayed
start date.

STARTMMDDYY=mmddyy

STARTDDMM Y'Y =ddmmyy

STARTHHMM SS=hhmmss
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Start data logging now, as defined by
INTERVAL. Datais stored in FLASH
memory. Datais transmitted real-time if
TXREALTIME=Y. Reset running
averageto 0.

Set delayed start month, day, and year for
datalogging, as defined by INTERVAL.
This command must be followed by
STARTHHMM SS= command to set
delayed start time.

Set delayed start day, month, and year for
datalogging, asdefined by INTERVAL.
This command must be followed by
STARTHHMM SS= command to set
delayed start time.

Set delayed start hour, minute, and second
for datalogging, as defined by
INTERVAL.
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Notes:

» After receiving STARTLATER,
the SBE 48 displays not
logging: waiting to start in reply
to the Display Status (DS)
command. Once logging has
started, the DS reply indicates
logging data.

« If the delayed start time has
already passed when
STARTLATER is received, the
SBE 48 executes STARTNOW.

STARTLATER

SAQS

STOP

Note:

You may need to send the STOP
command several times to get the
SBE 48 to respond. This is most
likely to occur if sampling
continuously or with a small
INTERVAL and transmitting real-time
data (TXREALTIME=Y).

Start data logging at time set with delayed
start date and time commands, as defined
by INTERVAL. Datais stored in FLASH
memory. Datais transmitted real-time if
TXREALTIME=Y. Reset running
averageto 0.

Example: Program SBE 48 to start logging on
20 January 2000 12:00:00.

SSSTARTMMDDY'Y=012000
SSSTARTHHM M SS=120000

S>STARTLATER

or

SSSTARTDDMM Y'Y =200100
SSSTARTHHM M SS=120000

SSSTARTLATER
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Transmit running average of
temperature data.

Transmit running average of temperature
data, and turn power off (put SBE 48 in
quiescent mode).

Stop data logging (that was started with
STARTNOW or STARTLATER) or
stop waiting to start logging (if
STARTLATER was sent but logging has
not begun yet). Press Enter key to get an
S> prompt before entering this command.
This command must be sent before
uploading data using the Upload button on
the Toolbar, Upload Datain the Data
menu, or the DDb,e command.
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Note:

The SBE 48 has a buffer that stores
the most recent data sample.
Unlike data in the FLASH memory,
data in the buffer is erased upon
removal or failure of the battery.

Operating Commands

These commands are used by an external controller to request a sample from
the SBE 48.

TS Take sample and transmit converted data.
Datais not stored in FLASH memory.
Do not send this command if SBE 48 is
logging data.

TSR Take sample and transmit raw data.
Datais not stored in FLASH memory.
Do not send this command if SBE 48 is
logging data.

SLT Transmit converted data from last sample
from buffer, and then take new sample.
Datais not stored in FLASH memory.
Do not send this command if SBE 48 is
logging data.

SLTR Transmit raw data from last sample from
buffer, and then take new sample.
Datais not stored in FLASH memory.
Do not send this command if SBE 48 is
logging data.

TSS Take sample, storein FLASH memory,
transmit converted data, and turn power
off. Do not send this command if SBE 48
islogging data.

TSSON Take sample, storein FLASH memory,
transmit converted data. Do not send this
command if SBE 48 islogging data.

SL Transmit converted data from last sample
from buffer.
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Notes:

» To save data to a file, click
the Capture button on the
Toolbar before entering the
DDb,e command.

» See Data Output Formats after
these Command Descriptions.

» Use the Upload button on the
Toolbar or Upload Data in the
Data menu to upload data that
will be post-processed by
SEASOFT. Manually entering the
data upload command does not
produce data in the correct
format for post-processing
by SEASOFT.

Data Upload Command

Send the STOP command before uploading data.

DDb,e Upload data beginning with sample b,
ending with sample e. First sampleis
number one.

Asthe datais uploaded, the screen first
displays start time =, sampleinterval =,
and start samplenumber =. These are
the start time, sample interval, and starting
sample number for the last set of logged
data. Thisinformation can be useful in
determining what data to review.

Example: Upload samples 1 through 200:

(Click Capture on Toolbar and enter the desired filename in the
dialog box.)

S>DD1,200

Testing Commands

Data obtained with these commands is not stored in the SBE 48's
FLASH memory.

TT Measure temperature for 100 samples
or until Esc key is pressed, output
converted data.

TTR M easure temperature for 100 samples or
until Esc key is pressed, output raw data.
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Coefficients Command

Notes:

» Dates shown are when calibrations
were performed. Calibration
coefficients are initially factory-set
and should agree with Calibration
Certificates shipped with SBE 48.

» See individual Coefficient
Commands below for definitions of
the data in the example.

DC

Note:
F = floating point number
S = string with no spaces

Display calibration coefficients.
Equivalent to Coefficients button on
Toolbar.

Example: Display coefficients for an SBE 48.

SSDC

SBE48V 1.0 0916
temperature:  28-jul-00
TAO= -9.420702e-05

TAl= 2.937924e-04

TA2= -3.739471e-06

TA3= 1.909551e-07

rtc: 28-jul-00
RTCAO= 9.999782e-01
RTCAl= 1.749351e-06
RTCA2= -3.497835e-08

Theindividual Coefficient Commands listed below are used to modify a
particular coefficient or date;

TCALDATE=S Temperature calibration date
TAO=F Temperature AO

TAl=F Temperature A1

TA2=F Temperature A2

TA3=F Temperature A3
RCALDATE=S Real-time clock calibration date
RTCAO=F Real-time clock A0

RTCA1=F Real-time clock A1

RTCA2=F Real-time clock A2
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Data Output Formats

Note:
t = temperature

(degrees Celsius, ITS-90)
hh:mm:ss = hour, minute, second
dd mmm yyyy = day, month, year

The SBE 48 transmits data in engineering units (except in response to the TSR
and SL TR commands, which request raw data). The exact format of the output
varies, as described below.

*  OQutput to Terminal Program after Sending Operating Command
(TS, SL,SLT, TSS, TSSON)
ttt.tttt, dd mmm yyyy, hh:mm:ss

*  Output to Terminal Program if Transmitting Real-Time Data
(TXREALTIME=Y)
# ttt.tttt, dd mmm yyyy, hh:mm:ss

* Output to Terminal Program after Sending Data Upload
Command (DDB,g)
ttt.tttt, dd mmm yyyy, hh:mm:ss

* Output to .ASC file after Sending Data Upload Command
(Upload button on Toolbar or Upload Data in Data menu)
ttt.tttt, dd mmm yyyy, hh:mm:ss

Uploading Data

Note:

While uploading data, Warning: Low

Battery Voltage may be displayed.

Follow one of these procedures to

continue uploading:

« Connect power to the I/O connector
red and black wires, to provide
external power. This prevents loss of
clock information and data in the
256 byte cache buffer. Once external
power is in place, you can replace
the internal battery without loss of
clock information or data.

« Remove the internal battery and
install a new one. The momentary
loss of power resets the clock,
preventing analysis of any clock drift,
and erases the 256 byte cache buffer
data (most recently recorded data,
corresponding to 36 data samples).

Note that all but the most recent data is

stored in non-volatile FLASH memory,

which is not affected by loss of power.

See Section 5: Routine Maintenance

and Calibration for replacement of the

internal battery. See Memory in

Appendix I: Functional Description for a

discussion of the cache buffer.

1. If not already installed, install the I/O cable connector and connect it to an
external power supply and to your computer’s serial port. See Power and
Communications Test in Section 3: Preparing the SBE 48 for Deployment
for details.
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Note: 2.
Set up Upload Settings, Header
Information, and/or Header Form 3.

(Steps 3 through 5):

» The first time you upload data, and

« If you want to change upload or
header parameters.

Baud rate for uploading data
from SBE 48 to computer. For
the SBE 48, this is the same as
the baud rate for general
communication, which was set
on the COM Settings tab.

Defines data upload type when
using Upload button on Toolbar or
Upload Data in Data menu:

¢ All as single file — All data
uploaded into one file.

* By scan number range —
SEATERM prompts for beginning
and ending scan (sample)
numbers, and uploads all data
within range into one file.

4.

Defines header
information included with
uploaded data:

* Prompt for header
information — Each
time data is uploaded,
user is prompted to fill
out user-defined
header form.

¢ Include default header
form in upload file —
User-defined default
header form included in
upload file. User is not
prompted to add any
information when data
is uploaded.

¢ Don't include default
header form in upload
file — Header
information not
included in upload file.

Double click on SeaTerm.exe. The display shows the main screen.

In the Configure menu, select SBE 39. Click on the Upload Settings tab.
The dialog box looks like this:

SBE 39 Configuration Dptions

COM Sethings T Llplnadﬂettlngxp i/ Header Infarmation

T UplgadBaud iate

i Upload data ..
 Albas s angle fle v By stan miml:giér fanige
[ 8 ¥Emetan

L e mEmIEkzE i

Canel | Qave-ﬁsl Dretault | Help | oK |

Make the selection for Upload Settings.

Click on the Header Information tab. The dialog box looks like this:
SBE 39 Configuration Options

COM Settings T Upload Seltings T: Hieader intomation: |

P Header Infarmatian.
(¥ Prompt for headet information
€ Inchude default header form in the upload file
1 Dot include default hieader form i te ypload file

Eancel | 'E;ave-.&sl Difault | Help | oK |

Select the desired header information option. Click OK to overwrite an
existing configuration file, or click Save Asto save the configuration as a
new filename.
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5.

In the Configure menu, select Header Form to customize the header.
The dialog box looks like this (default prompts are shown):

w. Edit Hesder Prompis

Fromptfarfine 1. [Skip
Prammpt far line 2 '||:. ligE
Frampt far line & |';;|.:.|.:..-

Fromptforfing 4 [Lotn.de
Fromptforline 5: [Longnase
Framiptfor line §: |
Frompifor line 7 |
Frampt for line & |
Frompt for line 9 |
3
|
|

Prampt for lme 10
Prampd for ling 11

Eramptfof lne 12

Cancel (5] 4

The entries are free form, 0 to 12 lineslong. This dialog box establishes:

» the header prompts that appear for the user to fill in when uploading
data, if Prompt for header information was selected in the
Configuration Options dialog box (Step 4)

» the header included with the uploaded data, if Include default header
formin upload file was selected in the Configuration Options dialog
box (Step 4)

Enter the desired header/header prompts. Click OK.

Click Connect on the Toolbar to begin communications with the SBE 48.

The display looks like this:

SBE 48

S

This shows that correct communications between the computer and the

SBE 48 has been established.

If the system does not respond as shown above:

»  Click Connect again.

»  Check cabling between the computer and the SBE 48.

*  Verify the correct instrument (SBE 39) was selected and the COM
settings were entered correctly in the Configure menu.

Command the SBE 48 to stop data logging by pressing the Enter key and
sending the STOP command.
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8.

Note:
Sea-Bird software does not correct
for clock drift.

Notes:

To prepare the SBE 48 for

re-deployment:

1. After all data has been uploaded,
send the SAMPLENUM=0
command. If this command is not
sent, new data will be stored after
the last recorded sample,
preventing use of the entire
memory capacity.

2. Do one of the following:

» Send the QS command to put
the SBE 48 in quiescent (sleep)
mode until ready to redeploy.
Leaving the SBE 48 with the
battery in place and in
guiescent mode retains the
date and time. The quiescent
current is only 10 microamps,
so the battery can be left in
place without significant loss
of capacity.

» Use STARTNOW to begin
logging immediately.

» Set a time and date for logging
to start using STARTDATE,
STARTTIME, and
STARTLATER.

10.

Display SBE 48 status information by clicking Status on the Toolbar.
The display looks like this:

SBE 48V 1.0 SERIAL NO. 0916 08 Aug 2000 08:49:09
not logging: received stop command

sampleinterval = 30 seconds

number of samplesto average = 60

samplenumber = 202, free = 299391

serial sync mode disabled

real-time output disabled

temperature=19.48 deg C

Compare the SBE 48’ sreal-time clock datato actual time. This
information can be useful later, if you need to correct for clock drift.

Click the Upload button on the Toolbar to upload stored data. SEATERM

responds as follows before uploading the data:

A. SEATERM sendsthe status (DS) command, displays the response,
and writes the command and response to the upload file. This
command provides you with information regarding the number of
samplesin memory.

B. If you selected By scan number rangein the Configuration
Optionsdialog box (Configure menu) — adialog box requests the
range. Enter the desired value(s), and click OK.

C. SEATERM sendsthe calibration coefficients (DC) command,
displays the response, and writes the command and response
to the upload file. This command displaysthe SBE 48's
calibration coefficients.

D. If you selected Prompt for header information in the
Configuration Optionsdialog box (Configure menu) — adialog
box with the header form appears. Enter the desired header
information, and click OK.

E. Inthe Open dialog box, enter the desired upload file name and
click OK. The upload file has a .ASC extension.

F. SEATERM sends the data upload command (ddb,e).

G. When the data has been uploaded, SEATERM shows the S> prompt.

Ensure all data has been uploaded from the SBE 48 by reviewing the data.

Sea-Bird provides two options for reviewing/processing the data:

* UsePLOT39to plot the ASCII (.ASC) data.

See Appendix I1: PLOT39 Data Plotting Program for details.

* Use SEASOFT’s Convert module (CNV 39) to convert the .ASC file
toa.CNV file, and then use SEASOFT to processthe (.CNV) file.
SEASOFT includes many post-processing modules; modules
applicable to the SBE 48 include ASCII OUT and SEAPLOT.

» CNV39 converts date and time (if present in the uploaded file) to
Julian Days, with five significant digits. Asthe default,
CNV 39 does not reset Julian Day to 0 when rolling over from
December 31 to January 1. To reset the Julian Day to 0 on
January 1, run CNV 39 with the command line option -r.
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Section 5: Routine Maintenance

and Calibration

This section reviews corrosion precautions, sensor calibration, and
replacement of the battery. The SBE 48's accuracy is sustained by the care and
calibration of the sensor and by establishing proper handling practices.

Corrosion Precautions

When used as described in this manual, the SBE 48 is not exposed to seawater.
No corrosion precautions are required. The SBE 48 should be rinsed with fresh
water after use and prior to storage.

Sensor Calibration

Sea-Bird sensors are calibrated by subjecting them to known physical
conditions and measuring the sensor responses. Coefficients are then
computed, which may be used with appropriate algorithmsto obtain
engineering units. The temperature sensor on the SBE 48 is supplied fully
calibrated, with coefficients printed on the Calibration Certificate (see back of
manual). These coefficients have been stored in the SBE 48's EEPROM.

We recommend that the SBE 48 be returned to Sea-Bird for calibration.

The primary source of temperature sensor calibration drift is the aging of the
thermistor element. Sensor drift will usually be a few thousandths of a degree
during the first year, and less in subsequent intervals. Sensor drift is not
substantially dependent upon the environmental conditions of use, and —
unlike platinum or copper elements — the thermistor isinsensitive

to shock.
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Replacing Battery

Phillips-head screw
(12 places)

-

Do not remove 2 screws on temperature sink

Battery cap -
remove Phillips-head screw

Battery cap -
remove mounting post

Remove battery cap

Note:
Before delivery, a desiccant package
is placed in the housing, and the
electronics chamber is filled with dry
Argon. These measures help prevent
condensation. To ensure proper
functioning:
1. Install a new desiccant bag each
time you change the battery.
2. Dry gas backfill each time the
electronics are exposed to
the atmosphere, unless more
than 24 hours will pass prior
to deployment.

Sea-Bird ships the SBE 48 with a 9-volt lithium battery installed. If the
SBE 48 is supplied with external power, the battery only powers the real-time
clock and should last for five to ten years.

Follow the instructions below to change the battery. This battery is non-
hazardous (as defined by IATA or US DOT) and can be shipped either
separately or installed in the SBE 48.

1. Remove the cover and electronics from the housing:

A. Wipethe outside of the cover and housing dry, being careful to
remove any water at the seam between them.

B. Remove the twelve Phillips-head screws (around the perimeter of the
cover) that secure the cover to the SBE 48. Carefully remove the
cover and electronics - the connector is electrically connected to the
electronics with a Molex connector.

C. Remove any water from the cover O-ring and mating surfaces with a
lint-free cloth or tissue.

Replace the battery:

A. Remove the Phillips-head screw and grommet on the white battery
cap.

B. Remove the mounting post on the battery cap.

C. Pull the battery cap off the battery.

D. Unsnap the old battery and replace with the new one.

(Thecircuit is reverse polarity protected. Accidental contact will not
harm the SBE 48).
E. Reinstall the battery cap with grommets (top and bottom), mounting

post, and Phillips-head screw.

3. Reinstal the electronics and cover:

A.
B.

Remove the old desiccant bag and replace with a new one.
Remove any water from the O-ring and mating surfaces with alint-
free cloth or tissue. Inspect the O-ring and mating surfaces for dirt,
nicks, and cuts. Clean as necessary. Apply alight coat of O-ring
lubricant (Parker Super O Lube) to O-ring and mating surfaces.
Carefully fit the cover onto the housing.

Install the twelve Phillips-head screws to secure the cover to

the housing.
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Glossary

Battery — 9-volt lithium battery

CNV39 — SEASOFT module to convert ASCII (.LASC) data uploaded with
SEATERM to SEASOFT format (.CNV). When converted to .CNV format,
the SEASOFT post-processing modules can be used to further analyze and

display data.

PCB — Printed Circuit Board.

PLOT39 — Sea-Bird’s WIN 95/98/NT software for plotting SBE 48
(and SBE 39) data.

SBE 48 — High-accuracy temperature recorder.
Scan — One data sample containing temperature and date and time.

SEASOFT — Sea-Bird’'s Data Analysis Software, which calculates and
displays temperature.

SEATERM — Sea-Bird’ s WIN 95/98/NT software used to communicate with
the SBE 48.
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Appendix |: Functional Description

Sensor

The SBE 48 includes the same temperature sensor element (pressure-protected
thermistor) previously employed in Sea-Bird's modular SBE 3 sensor,
SEACAT family, and SBE 39.

Sensor Interface

Temperature is acquired by applying an AC excitation to a hermetically sealed
VISHAY reference resistor and an ultra-stable aged thermistor with a drift rate
of lessthan 0.002°C per year. A 24-bit A/D converter digitizes the outputs of
the reference resistor and thermistor. AC excitation and ratiometric
comparison using a common processing channel avoids errors caused by
parasitic thermocouples, offset voltages, |eakage currents, and reference errors.

Real-Time Clock

To minimize battery current drain, alow power watch crystal is used as the
real-time-clock frequency source. The sensitivity of the clock to ambient
temperature is accurately measured during calibration. The results are stored in
EEPROM and automatically applied during deployment.

Memory

Data

The SBE 48 hasa2 MB FLASH memory for data storage. FLASH memory is
non-volatile, and datain the memory is not lost as aresult of depletion or
removal of the battery. Because FLASH is written to a page (256 bytes) at a
time, datais first accumulated in a 256 byte cache buffer. When the cacheis
full, its contents are transferred to FLASH memory. The cacheis volatile, and
thus depends on battery power. That is why an SBE 48 with depleted battery
will loseits most recently stored data unless an external power supply is used
(see Uploading Data in Section 4: Deploying and Operating the SBE 48).

The data upload process integrates the data from the FLASH memory with the
data from the cache. The SAM PLENUM command controls the memory
pointers that manage this process. Setting SAM PLENUM to zero resets the
pointer in the FLASH memory as well as the pointer in the cache memory,
causing the SBE 48 to overwrite existing data. It is important not to change
SAMPLENUM until al the data has been uploaded.
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If SAMPLENUM isinadvertently set to zero before datais uploaded, and you
wish to upload data, the following conditions apply:

Was additional | User then Description of Uploaded Data

data logged returns

after SAMPLENUM

SAMPLENUM | to:

was changed?

No Original value | All data (datain FLASH aswell as

datain cache) uploads correctly.

No Estimated value | All datain FLASH uploads correctly.
larger than Datain cacheis corrupted (minimum
original value of 0 and maximum of 36 scans).

Yes- lessthan | Original value Old datain FLASH uploads correctly.

256 bytes of Old datain cacheis corrupted. First

new data scan of new datain cacheis corrupted;

(corresponding remaining scans of new datain cache

to 36 scans of upload correctly.

temperature)

Yes- more Original value Old datain FLASH is overwritten with

than 256 bytes new data. Old datain cacheis

of new data corrupted. If the new data set is smaller

(corresponding than the old set, a portion of the old set

to 36 scans of can be recovered; the scan bridging old

temperature) and new datais corrupted. First scan of

new datain cacheis corrupted;
remaining scans of new datain cache
upload correctly.

Timekeeping

Timeis stored in volatile memory. If power isremoved, the clock resets
to 1 January 1980. Upon restoration of power, the clock resumes

normal operation.

Settings

Calibration coefficients and setup and operating parameters (BAUD,
SAMPLENUM, INTERVAL, etc.) are written to EEPROM and are
non-volatile. These settings do not change if power is removed.
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Appendix II: PLOT39 Data Plotting Program

£ Untitled - Plot39 [_ O] =]
Notes: File Edt Setup View Help
» Pressure plot shown in the = 3 = ‘?|
figure is not applicable to
the SBE 48.
: , , Plot Data
» Help files provide detailed
information on the use
of PLOT39.
25 989 4 401513
o
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o ©
D 24283 39513
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PLOT39 isused to plot ASCII data (.LASC file) that has been uploaded from

the SBE 48. PLOT39:

» Plotsthedatain color. The plot can be saved as a graphic file for
presentation.

* Improves display speed with data culling. PLOT39 plots every Nth data
value, where N is dependent on the number of data values to be displayed
and the width of the display rectangle in pixels.

* Allowsaxisand font sizes to be easily changed.

* Allowsasection of aplot to be magnified to reveal more detail.

If not already installed, install PLOT 39 and other Sea-Bird software programs
on your computer using the supplied software CD:

1. Insertthe CD inyour CD drive.

2. Double click on Setup.exe.

3. Follow the dialog box directions to install the software.

The default location for the software is ¢:/Program Files/Sea-Bird. Within that
folder is a sub-directory for each program.
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Appendix lll: Command Summary

CATEGORY [COMMAND DESCRIPTION
Status DS Display status.
Setup MMDDYY= Set real-time clock month, day, year.
mmddyy Must follow with HHM M SS=.
DDMMYY= Set real-time clock day, month, year.
ddmmyy Must follow with HHM M SS=.
HHMM SS= Set real-time clock hour, minute, second.
hhmmss
BAUD=x x= baud rate (1200, 2400, 4800, 9600,
19200, 38400). Default 9600.
NAVG=n n= number of scansin running average
(1-120).
TXREALTIME=x [X=Y: Output rea-time datato computer.
Does not affect storing data to memory, but
dlightly increases current consumption.
x=N: Do not output real-time data.
SYNCM ODE=x x=Y: Enable Serial Line Sync Mode.
When RS-232 RX lineishigh (3-10 VDC)
for 1 - 1000 milliseconds, SBE 48 takes a
sample, stores datain FLASH memory,
transmits real-time data (if
TXREALTIME=Y), and powers down.
x=N: Do not enable Seria Line Sync Mode.
Qs Enter quiescent (sleep) mode. Data logging
and memory retention unaffected.
Logging SAMPLENUM=n |Set sample number for first sample when

logging beginsto n. After al previous data
has been uploaded, set to zero before starting
to log to make entire memory available for
recording. If not reset to zero, data stored
after last sample.

INTERVAL=n Set interval between samples to n seconds
(0, or 3 - 32767). When commanded to start
sampling with STARTNOW or
STARTLATER, SBE 48 takes sample,
stores datain FLASH memory, transmits
real-time data (if TXREALTIME=Y), and
powers down at n second intervals. If n=0,
SBE 48 samples continuously without
powering down between samples.

STARTNOW Start logging now, as defined by
INTERVAL. Reset running average to 0.

STARTMMDDYY |Delayed logging start: month, day, year.

=mmddyy Must follow with STARTHHM M SS=.

STARTDDMMYY |Delayed logging start: day, month, year.

=ddmmyy Must follow with STARTHHM M SS=.

STARTHHMMSS |Delayed logging start: hour, minute, second.

=hhmmss

STARTLATER Start logging at delayed logging start time,
asdefined by INTERVAL. Reset running
average to O.

SA Transmit running average of data.

SAQS Transmit running average of data, and
turn power off.

STOP Stop logging or stop waiting to start logging.

Press Enter key to get S> prompt before
entering this command. Must send this
command before uploading data.
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Appendix Ill: Command Summary

Note:

Use the Upload button on the
Toolbar or Upload Data in the
Data menu to upload data that
will be post-processed by
SEASOFT. Manually entering the
data upload command does not
produce data in the correct format
for post-processing by SEASOFT.

CATEGORY |COMMAND DESCRIPTION

Operating TS * Take sample and transmit converted data.
Data not stored in FLASH memory.

*Donotsend |TSR * Take sample and transmit raw data. Data not

these stored in FLASH memory.

. SLT * Transmit converted data from last sample
cs:%rrén;%nldss it from buffer, and then take new sample. Data
. not stored in FLASH memory.

logging data. SLTR * Transmit raw data from last sample from
buffer, and then take new sample. Data not
stored in FLASH memory.

TSS * Take sample, store datain FLASH memory,
transmit converted data, and turn power off.

TSSON * Take sample, store datain FLASH memory,
and transmit converted data.

SL Transmit converted data from last sample
from buffer.

Data Upload |DDb,e Upload data beginning with scan b, ending
with scan e. Send ST OP before sending
this command.

Testing TT M easure temperature for 100 samples
or until Esc key is pressed, output
converted data.

TTR M easure temperature for 100 samples or
until Esc key is pressed, output raw data

Coefficients |DC Display calibration coefficients; all

(F=floating coefficients and dates listed below are

point number; included in display. Useindividua

S=string with commands below to modify a particular

No spaces) coefficient or date.

TCALDATE=S Temperature calibration date.

Dates shown TAO=F Temperature AO.

are when TA1=E Temperature AL

cibrations [T A>-F Temperature A2.

\geerrfirm o TA3=F Temperature A3,

Calibration RCALDATE=S Real-time clock calibration date.

coefficients are |RTCAO=F Real-time clock AO.

initially factory- | RTCA1=F Real-time clock A1l.

setand should |RTCA2=F Real-time clock A2.

agree with

Cdlibration

Certificates

shipped with

SBE 48.
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Appendix IV: Replacement Parts

Part Part Application Description Quantity in
Number SBE 48
30845 |Screw, 10-24 x 11/4” Secure cover to housing at 12
flat-head, Phillips-head, |cornersand at magnet
stainless steel mounting bars
30144 |Screw, 6-32 x 7/16” Secure Battery/PCB 2
truss, Phillips-head, end caps
stainless steel
31109 |Grommets Isolate PCB from mounting 4
posts
31111 | Spacer, 6-32 x 13/8" hex, |Mounting post for 2
aluminum Battery/PCB end caps
31121  |O-ring, Seal between cover 1
2-263N674-70, Parker |and housing
22074  |Battery, 9-volt lithium |Power SBE 48
32442  |5-pinl/O cable From SBE 48 to computer
17130 |25-pinto 9-pin adapter |Connects 1/O cable to 9-pin
COM port on computer
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